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Welcome From The Chief Editor
I recently went deer hunting. As I was sitting in the tree stand, it was hard to not notice the deafening silence. In that silent realm, you can hear everything. Until it's that quiet, you have no idea how much noise a single, dried leaf makes as it falls from its supporting branch and flutters to the ground. A squirrel that weighs maybe a pound, sounds as if he's 40 pounds as it scampers through the leaves. The periodic tapping of a woodpecker echos through the woods as it looks for another insect to eat. Geese honk in the distance. Gravel crunches under the tires of a car traveling down a distant road.
That's one thing I really like about being in the outdoors, whether it's fishing or hunting. The peace and solitude envelopes you. Little else seems to matter as you're able to escape the hustle and bustle of everyday life. The theme songs from my son's favorite kiddie shows blare loudly in my head.

Me, sitting in the tree stand.
In a way, it all also reminds me of what it's like to use PCLinuxOS. With it, we're able to free ourselves from the everyday hassles that go along with using that "other" commercial operating system that dominates the computer landscape. Many thanks to Texstar and his small group of packagers that keep PCLinuxOS running like a well oiled machine.
We don't have to deal with viruses, malware, spyware and crapware. We don't have to worry about spending obscene amounts of money for the programs we rely on to get our daily tasks done. We have choices not only in the software we use, but we also have choices in desktop environments and how to set up how our computer works. We have the choice to use lots of eye candy, or hardly any at all.
We are free from all that background noise that those problems and issues bring with them. I guess you could say that we have freed ourselves from the Matrix. And, as computer users, our computer lives are enrichened by that freedom.
During this holiday season, I wish for each of you happiness, peace, serenity and prosperity.
Inkscape Tutorial: Another Fun Text Effect
By Meemaw
I was talking to ms_meme the other day about ways to manipulate text in Inkscape, and one of the extensions we discussed was the Envelope extension. Envelope is an extension that will "mold" text to a rectangular shape. Let's do one!
Start with the bezier tool and draw a rectangle. You have to make it a rectangle for the extension to work. If you want a triangle, you can draw a 4-sided figure that looks kind of like a triangle with one point cut off, as shown below.

Some of these extensions are picky about how you draw them. Envelope requires the figure to be drawn in this order: top left, top right, bottom right, bottom left, and close. Change your rectangle to a path by clicking Path > Object to path.

Once you change it to a path, you can always go in and move the nodes around to get the shape you want. It has to be four-sided, but the four sides can be any way you want. If you want a banner shape (or any other four-sided shape), just move the nodes until you are satisfied with the result. The text will align with the rectangle along the first and fourth lines, with the top of the word being against the first line and the left side of the first letter being against the fourth line. When you move your nodes, keep this in mind.
Now for the text. Type and configure it, changing the font, size, etc., however you want. With your text selected, click on Path > Object to path. At this point, your text is a group of paths, with each letter being its own path. Ungroup your text, which will then look like this:

then click on Path > Combine and combine the text into one path.

Envelope works with only two paths. If you don't perform the above step, you will get an error message that says you have to have only two paths. Choose the word, (hold down <Shift>) and choose the shape, and then go to Extensions > Modify Path > Envelope.

After your text is changed, you can use or delete the shape, whatever you need to do for your drawing.

It's a fun process! With a little experimentation, you can get all sorts of effects.
ms_meme got this (which looks kind of like a tree):

This one's fun! I hope you have fun with it as well.



The ChimpBox: A Review

by Michael Duffy (tuxlink)
Like a child on Christmas morning, I was almost shaking with excitement the day the box arrived at my front door. This box held the contents of which I had been talking, thinking and dreaming about for the previous few months since it first became an idea in a chat room with some of my fellow PCLinuxOS buddies. Now, it was here, and December was nowhere in sight. Truly, an early Christmas gift!
The need for a box like this has been increasing in popularity for some time now. After reading about and becoming curios of The Mintbox Mini, a product offered in the familiar green of the Linux Mint distro, I started to wish for a box that would fit that need, niche and price point also. Up to this, I had built full sized desktop machines without much difficulty. The biggest hurdle for me seemed to be the battle against heat here in Southern California. A room that is already hot, sucking air into a computer that has a great need to remain cooler can be a troublesome task. In the average home, A/C cannot be run all day long, (some of us work for a living!) and if extra fans are used in the case, noise becomes a factor. My current desktop machine, an AMD Athlon 3500+, has four fans in it. A CPU fan, a fan on the power supply, and two case fans. At first boot up you notice it run, after an hour or so, I find myself turning my speakers up a little! Not the end of the world by any means, but it's there.
Upon opening the box it arrived in, I am shocked at how small the ChimpBox enclosure is! It is 8 ¼" X 7 1/2" wide, and 2" tall. In anticipation of connecting it to my 22" Envision monitor, I went searching for a VGA cable, only to find I already had one plugged into the rear of the monitor waiting to go! I connected and then turned my attention to the power connector, the audio and USB keyboard and mouse. With all hooked up, I nervously leaned my thumb on the power switch located on the left of the front panel. It instantly glowed blue, and my screen came alive!

"Oh crap, what's wrong!" There was the boot process happening before my eyes, and rather quickly I might add, but I was missing something. Something primal was missing. "What the...?" There was no sound. Nothing! No fans, no whirring, no buzzing, no creaking,... nothing. It was glorious silence. The one huge factor about the ChimpBox is that it is silent. In the following hours of use, I must have leaned over to check to see if it was still on. And yes, there it was, running silently, with it's calming blue glow.
I wondered how it would fare with heat dispersion. Both sides, the front and the top have plenty of holes for venting any heat that builds up. After a number of hours using it, it had barely even become warm to my hand.
The sight of an activity LED flashing on and off gives you a small clue whether a machine is alive, but there is nothing but the constant blue power light to calm your curiosity. One thing I am impressed with is the boot up time. I have a password entry at the login screen and including typing that in, this baby boots up in thirty one seconds! I could set it up to bypass the login, but either way, it's the fastest booting machine I have ever owned. I could go through the specs of the machine line by line, but then if you're interested in buying a ChimpBox, you can read through all of them at the website. One thing I will say about the wireless adapter that sits behind the front panel, is that it has very easily found and kept a strong 82% wifi signal from my router located about 25-30 feet away in another room on the same floor. The ChimpBox does come with an RJ-45 Ethernet port, so if you happen to be located close to your router, a wired connection is always a nicer (and faster) option.
I have been using the box for a few weeks now, and I can say it is easily able to run everything that PCLinuxOS KDE can throw at it. I have burned three DVD's through an external burner via USB and it tore through that in no time flat. I have used Gimp to make wallpapers for the ChimpBox, and it is impressive to see the tools zip through the tasks so easily.
Some folks might not like the size of the AC/DC adapter, commonly known as 'the brick'. It is 6 1/2" long by 2" wide. I have seen 17" laptops with bricks that were half the size of this. Tucking it away though, like under a desk or behind the monitor, helps the 'out of sight, out of mind' thing to work for you.
One thing I wanted to do on the new ChimpBox was export some video and see how it handled it. I created a short video that runs for just 3 minutes, including still images and a soundtrack. I set the export for a high def and high quality, hit the 'Export' button, and started my stopwatch. It took exactly 8 minutes and 12 seconds to render the video into an .mp4 file. I was quite impressed with that, and if I had selected a lower quality (like for the web etc...), it may have been even quicker.
All ChimpBoxes come with a recovery USB thumb drive. It holds the OS and works just like a Live CD/DVD. If you happen to really mess things up on the desktop, or anywhere else, this drive restores you to day one, in no time at all. The OS that comes as default on the ChimpBox is PCLinuxOS KDE. If new users to Linux find it unfamiliar to get around at first, there is a wealth of knowledge available at the PCLinuxOS website, with a friendly helpful community waiting at the ready to help with any issue that may arise. The ChimpBox offers a great deal of value to new and experienced users alike, at an affordable price and in a neatly sized package.
The only question left is, have you been good enough to get one this Christmas?


ms_meme's Nook: No Place Like The Forum
PCLinuxOS Recipe Corner: Tofu Parmigiana

Tofu Parmigiana

INGREDIENTS:
1/2 cup seasoned bread crumbs
4 tablespoons grated Parmesan cheese
2 teaspoons dried oregano, divided
1 (14 ounce) package extra firm tofu
2 tablespoons extra-virgin olive oil
1 (18 ounce) can/jar marinara sauce
1/2 teaspoon dried basil
13 clove garlic, minced
4 ounces shredded mozzarella cheese
1 egg, beaten
pepper, to taste
DIRECTIONS:
In a small bowl, combine bread crumbs, 2 tablespoons Parmesan cheese, 1 teaspoon oregano, salt, and black pepper.
Slice tofu into 1/4 inch thick slices and press water out of tofu using paper towels. Coat tofu in egg and one at a time, press tofu slices into crumb mixture, turning to coat all sides.
Heat oil in a medium skillet over medium heat. Cook tofu slices until crisp on one side; turn, and brown on the other side.
Combine tomato sauce, basil, garlic, and remaining oregano. Place a thin layer of sauce in an 8 inch square baking pan. Arrange tofu slices in the pan. Spoon remaining sauce over tofu. Top with shredded mozzarella and remaining 2 tablespoons Parmesan.
Bake at 400° F for 20 minutes. Serves 5.


Holiday Gift Guide: parnote's Picks
by Paul Arnote (parnote)
It's that time of year. The holidays are upon us, once again. With that in mind, it's also time for The PCLinuxOS Magazine's annual gift guide. Between me, Meemaw and YouCanToo, we're going to present 30 gift ideas that might help you buy gifts for that "hard-to-buy-for techie" on your holiday shopping list. You can also help PCLinuxOS by purchasing gifts from the official PCLinuxOS store on CafePress, and I've featured some of those items below. PCLinuxOS receives a portion of the profits from the sale of each item in the official PCLinuxOS store. Also, all prices are expressed in U.S. dollars.
KINGWIN KW-HUB-9U3 9 Port SuperSpeed USB 3.0 Hub ( 7 x USB3.0 Port + 2Port IQ smart Charging) Newegg ... $31.99

It doesn't seem to matter how many USB ports you have on your computer, you can always use more. This USB hub features seven (7) high speed USB 3.0 ports, along with two IQ Smart charging ports. Sure, there are hubs that are less expensive, but this one is externally powered -- so you'll need to plug it into the wall, as well. Once connected to an open USB 3.0 port on your computer, you'll have not only seven additional USB 3.0 ports to power all of you peripherals, you'll also have two intelligent charging ports to charge your smartphone, tablet and other devices.
PCLinuxOS Value T-Shirt Official PCLinuxOS Store ... $13.99

Look great in this value priced t-shirt, emblazoned with the PCLinuxOS logo. Made of midweight 100% cotton, this shirt is perfect for warm summer days or just lounging around the house. Let the world know about the best operating system ever by wearing it around town. This shirt is only available in white, and in adult men's sizes small to 4XL.
Silicon Power S60 3K P/E Cycle Toggle MLC 2.5" 120GB 7mm SATA III 6Gb/s Internal Solid State Drive (SSD) Newegg ... $41.99

Want to breathe new life into an older computer? Replace the existing SATA III magnetic hard drive with a SATA III SSD (solid state drive). Not only will your computer boot in record time, but you won't believe how responsive and fast your older computer becomes. Like a lot of SSDs, this fits into a 2.5" form factor, and it can be used in a notebook, netbook, or desktop computer (the latter will most likely require a mounting adapter, though). If digging around inside your computer isn't your cup of tea, you can also use this in an external drive enclosure and create a blazing fast external storage solution that can be moved between all of your computers. Just in case 120 GB isn't big enough for your liking, there is also a 240 GB version available on the same page for $67.99.
PCLinuxOS Clock PCLinuxOS Official Store ... $13.99

Keep track of how much time you've been on the computer with your own wall clock adorned with the PCLinuxOS logo. The 10 inch analog wall clock features precision quartz movements to guarantee accurate time, and is housed in a black plastic case with a clear plastic lens. It runs off of one AA battery, which is included.
Folding Adjustable Vented Laptop/iPad/Book Desk Stand, Portable Bed Tray - Black Newegg ... $26.99

One of the worst things you could do to your laptop (notebook) computer is to use it on your lap or other soft surfaces. Frequently, you block the ventilation holes, causing your laptop to run hot. In fact, it can run so hot that it causes burns to the skin. Plus, we all know (or should know) that heat is a mortal enemy of computers, and can shorten the lives of various computer components, especially CPUs, RAM and video chips.
So, if you like to lie in bed and cruise the internet, or sit in a chair with the computer in your lap, this item is for you. Not only does it provide a fairly stable platform for your computer, it keeps the computer off of soft, fluffy surfaces (like your bed), and off of your lap. In doing so, it improves air circulation around the computer, thus helping to keep your computer running cooler, and thereby helping extend the life of your computer and its components.
PCLinuxOS Coffee Mug PCLinuxOS Official Store ... $14.99

Have your morning cup of joe in a PCLinuxOS coffee mug! This mug comes in three sizes: small, medium and large. The small mug, at 11 ounces capacity, also changes color. When filled with a hot beverage, it changes colors from black to white, revealing the logo. The medium mug holds 15 ounces, costs $15.99, and does not change colors. The large mug holds 20 ounces -- over three times the size of a traditional coffee cup (a traditional serving size of coffee is six ounces). The 20 ounce mug costs $19.99, but does not change colors.
Star Wars #1 ThinkGeek Exclusive Variant ThinkGeek ... $7.99

With the release of Star Wars: The Force Awakens movie scheduled later this month on December 18th, Star Wars merchandise will be finding a new audience as millions discover the saga for the first time -- and as many millions more rediscover and revisit their longtime favorite serial about good vs evil. Star Wars "lore" is broken down into two categories: legend and canon. The former is unofficial, while the latter is the "official" history. Since the first release of the first movie (Episode IV: A New Hope) in 1977, there has been a steady stream of Star Wars lore released to fans hungry for more. As you can imagine, both categories of lore have filled up with tomes of information.
Now, there will be an official Star Wars comic book line coming out. And I do mean OFFICIAL. The comic books will be canonical. Here's your chance to get a special edition copy of the first issue, with a cover especially designed for ThinkGeek. The issues come bagged and boarded (you comic book collectors will know what that means), but ThinkGeek will not guarantee that you receive a mint condition graded copy. The storyline in these comic books pick up where the first movie (Episode IV) left off.
PCLinuxOS Baseball Cap PCLinuxOS Official Store ... $18.99

Available in white (pictured above) or tan, this 100% brushed cotton baseball cap has the PCLinuxOS logo printed on the front. The hat size is adjustable with a hook and loop strap in the back, allowing for proper sizing for virtually any head size. It also features a sweatband on the inside.
BB-8 Desktop Lamp ThinkGeek ... $39.99

In the new Star Wars movie, The Force Awakens, he doubles as a projector, a fire extinguisher, a navigator, and a power coupler. We know all the things that R2-D2 does, but we don't yet know all the things BB-8 has up its... well, up its metaphorical sleeves. Maybe it also doubles as a lamp in a sticky situation. We just don't know.
But it definitely can double as a lamp for you. This BB-8 Desktop Lamp stands 8 1/2" tall and casts light on your subject of choice, whether that's astronavigation or algebra. It has LED light inside the head, which shines downward through a diffuser. A gentle tap on BB-8's head switches between three different lighting modes: natural white, amber, and warm white. And off. Also a good mode when you need to go to sleep.
MTM Arrow Plus Case, Black Sportsman's Guide ... $31.99 ($28.79)

I keep it no secret that I like to hunt and fish, and enjoy all sorts of outdoor activities. In the last year, I took up learning archery. What I didn't anticipate was how quickly you accumulate arrows and all the accessories that go along with them. Broadheads and field tips, nocks, fletching material, threaded inserts ... the list goes on and on. So, it would be nice to have a single case where I could store all those arrows and assorted accessories. This case will store 36 -- three dozen -- arrows up to 35 inches (88.9 cm) in length (even though I cut my arrows to a length of 28 inches (71.1 cm) to accommodate my draw length).
We here at The PCLinuxOS Magazine would like to wish you and your families a wonderful, safe and happy holiday season.

2015 Holiday Gift Guide: Meemaw's Picks
by Meemaw
It's almost time to find those gifts that you hope are just right for each person on your gift list. Some of my picks are fun and some are strange, so if you need a fun or strange gift, one of the following might just be the one.
One of my favorite sites, as I have said before, is BITS & PIECES. They have toys and jigsaw puzzles (one of my faves), plus many gifts that other sites don't have.
Laser Scissors $9.99

When I first saw this, I thought, "Really?" However, I started thinking about it, and decided that this is a good idea. There are many places that I would want a straight line to follow. So, yes: laser scissors.
Melting Dali Clock $14.99

The painting "The Persistence of Memory" by Salvador Dali is really different, and if your home decor is this style, or you have a copy of the painting, this makes a wonderful addition. It is designed to hang on a shelf.
Kitchen Utensil Clock $19.99

While we are talking about clocks and home decor, this would be a cute design for one's kitchen.
Fiber-Optic Christmas Tree 18", 31", 4' and 6' $39.99 to $149.99

This might be a good alternative to a live evergreen tree (some people are allergic). It has two light disks, one white and one colors, and it comes in four different sizes.
Nail Art Pen Set $14.99 for each of 4 different sets

My granddaughters are older now, and many young girls (and their mothers!) are into the current nail design trend. This is one of four sets that will give you the supplies to do it yourself. Some are plain colors and some have glitter. Each set comes with four pens with brushes and fine tip pens to do the whole design.
Glow in the Dark Jigsaw Puzzle $18.99

Sky Full of Balloons Jigsaw $16.99

I guess my gift guide wouldn't be mine without at least one jigsaw puzzle. These are two that would be fun to assemble.
While not inexpensive by any means, L L BEAN has a wonderful assortment, and if you can afford them, the clothes don't wear out in the first year of wear. My husband has some of their flannel shirts, and they have lasted up to 10 years. In addition, they have other items that are very interesting.
Personal Travel Bag $24.95 (small) $29.95 (medium) $39.95 (large) $49.95 (family size)

Most everyone travels, and most people I know use some sort of bag to keep their personal items from moving around in the suitcase. L L Bean has an assortment of these bags in four different sizes, and in several different designs and colors. The one in the image is a medium size bag.
Lambswool Scarf $39.95

This might be a wonderful present for just one special person! Lambswool is sure to be really soft and warm.
First Watch Weather Station $39.95

This is a handy gadget for displaying indoor and outdoor temperature, plus time and date. It is easy to configure.
Snowman Family Kit $34.95

Twenty-six pieces in a handy bag will be all your family needs to build a snowman family, including a snow-dog. All you have to do is add the snow.
Have a great holiday season! I hope that you find that some of these suggestions are just the right selection for someone special.



2015 Holiday Gift Guide: YouCanToo's Picks
by YouCanToo
He's making a list and checking it twice. Going to check who's been naughty or nice.
The Chimpbox Quad Core Starting at $299.99

Good things comes in small packages this year. Measuring only 7.5 X 8.5 X 2 inches, The Chimpbox packs a punch. Zero noise, small footprint and low power usage. Comes preloaded with PCLinuxOS KDE.
Smartbean Bluetooth Receiver $23.99

The Smartbean Bluetooth Receiver is the latest in the line of Antec Mobile Products designed to free you from wires and tangled cables. Thanks to the Smartbean's use of Bluetooth High-Definition technology, you can go wireless with your favorite headphones and still retain CD quality sound and crystal-clear audio while listening to music, watching movies or playing games. But don't surrender control.tthe Smartbean's integrated microphone and audio controls let you adjust volume, pause and skip tracks and switch between audio and phone functions with a touch of a button--unlocking your mobile device's true potential.
Hey Joe Coffee + Mug $99.99

The Hey Joe Coffee Mug can brew your coffee inside of your mug at the push of a button, anytime, anywhere. It's the world's first smart coffee mug that you can take with you anywhere and brew coffee anytime. Add your coffee pod, add water and hit power -- it's that simple. In just a few minutes, you can enjoy a freshly-brewed cup of coffee wherever you are. On top of that, this kit includes a unique blend of coffee that will delight your taste buds in light, medium, or bold roast. This high quality, arabica coffee is specially formulated to taste better than any other coffee brewed in a Hey Joe Coffee Mug, guaranteed.
TrackR StickR $24.95

You likely lose your wallet, smartphone, keys and/or remote control frequently. Losing things is normal. But instead of dealing with the frustrations of losing these items, there's a better way to cope: the TrackR StickR. Where are the keys? Where did you put your wallet? Where is your phone? Trackr solves that problem. It is a quarter-sized device that can be fastened to any item, and then users are able to use the companion app to find whatever the device is attached to. When you lose your wallet, you simply pull up the app on your smartphone and you can make the StickR beep. You can also set up the app to alert you when you venture too far from it, and can use the TrackR StickR to also find your phone, even if it is on silent. It works with both iOS and Android. I have one attached to my remote control so I never have to worry about losing it.
Tablet Wall Mount Mount Dock $ 15.49

Ever lay in bed at night with your tablet binge-watching your backlog of shows and movies on Netflix and realize just how uncomfortable it is to have to hold the tablet while you watch? You need a tablet wall mount, and the easiest one to set up is the Koala Tablet Wall Mount Dock by Dockem. It works with virtually all tablets -- both iOS and Android devices -- and is easily set up in seconds. There are no screws or holes required, as it simply uses damage-free 3M Command adhesive strips for mounting, allowing you to mount it virtually anywhere in your home. Whether you need your tablet in the bedroom, garage, bathroom or kitchen, the Koala Tablet Wall Mount Dock can be placed anywhere. And, it's cheap enough so that it makes a great gift for her on a budget.
Google Chromecast $35.00

Wireless streaming sticks don't get any cheaper or easier to use than the Google Chromecast. This little HDMI dongle attaches to a TV, and using it is a snap. Simply open a supported app -- such as Netflix or Pandora -- on your laptop, tablet or smartphone, and hit the Cast button. Your content will show up instantly on your TV in full 1080p resolution, without any lag. You can even broadcast from a Google Chrome browser.
Polaroid Zip $130.00

The Zip is a super-simple photo printer. Turn it on, connect it to your iPhone or Android via Bluetooth, and hit the print button on a free app. The result: 2 x 3-inch instant prints. Don't worry about expensive ink cartridges, either. The Zip uses special photo paper (a 30-pack costs $14.99) that's ink-free and comes out dry-to-touch. You won't even need to shake them.
Smartphone Spy Lens $20.00

Sneak snapshots on the sly with this low profile lens that magnetically attaches to your phone. Designed to capture photos at a 90 degree angle, this device simply attaches to your phone's lens to act as a periscope for furtive shooting. With the ability to swivel the lens 365 degrees, you can lay your phone down flat in "texting position" and still shoot straight ahead, turning any surface into an impromptu tripod. Perfect for candids of your camera-shy friends, or when you need a little photographic evidence to back up an unbelievable story. Made in China.
Magic Cube Laser Virtual Projection Keyboard $96.95

It is a magical cube that is totally virtual. With this tiny portable gadget, now you can have the virtual keyboard wherever you are. What more a geek would want other than this?
Wireless Smart LED Soft White Bulb $134.00 for a 6 pack

Today's powerful man wants the control of everything. Let's get it started from your home. Keep the control of your bulbs and lights in the house with this LED soft white bulb, you can dim or highlight the bulbs through the setting in the mobile application. Manage it like you want.



PCLinuxOS Friends & Family Member Spotlight: bkstan
As told to YouCanToo.
What is your name/username?
My name is Stas, surname is Starodubtsev.
How old are you?
40
Are you married, single?
Married.
How about Kids, Grandkids?
A boy and a girl, very young ones.
Do you have pets, what is your favorite?
No.
Are you retired, still working and what do you do?
Working as an IT developer in a Moscow bank. Doing DB development, and front-end dev too. (Generally using C# and C++ on Windows, sometimes Python).
Where do you call home? What is it like? IE: weather, scenery
Well I live in a Moscow suburb.
Where did you go to school and what is your education level?
Well, I got pretty nice education, in a Moscow school in 1982-1992. and then at a Moscow state university in 1992-1997 as a mathematician (near to theoretical science, physics).
What kind of things you like doing? hobbies, travel, fishing, camping?
I'm fond of serving to people - in an altruistic manner. I love reading religious articles, as well, and I love my family and children. I love spending time in a our little forest wooden house in the summertime, and I am also interested in computer science and technology a lot.
Why and when did you start using Linux?
I love Linux because it is powerful, secure, smart, pretty stable, quick, extendable, ... I have so many good words for Linux in general, and for PCLinuxOS in particular!
Using this chance I ask you to convey a lot of thanks and good wishes to all PCLinuxOS crew in the USA and all over the world!
I tried many times Fedora, SLAX, Mandriva/Mageia, ASPLinux, what not ... still using this distro, I think since 2009.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by youcantoo, featuring PCLinuxOS forum members. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
ms_meme's Holiday Poems

Which Programming Language?
by Peter Kelly (critter)
Most of my previous submissions to the PCLinuxOS magazine have been in the form of tutorials or how-to's. This time, however, I thought that I would share my experiences with trying out a new programming language, the difficulties that I experienced, the relative advantages and disadvantages of the different languages, and the benefits of being able to use one, or more, computer languages to achieve the results you require from today's powerful computer systems.
For the lowdown on a whole bunch of computer languages, take a look at the "Computer Languages from A to Z" series published in the PCLinuxOS Magazine from July 2008 to February 2011, written by Gary L. Ratliff, Sr.
You may not realize just how powerful your computer actually is when using pre-packaged applications supplied with your distribution. They will, usually, make tasks easier but at the expense of compromising your requirements and providing a 'close fit' result.
You can write your own routines - not full blown applications such as word processors and spreadsheets, but little applications or scripts that get you the results that want, how you want them, in the format that suits your requirements. Writing your own routines can be achieved in a variety of ways, and there are many programming and scripting languages available to enable you to write them.
Writing a utility application to achieve your end result need not be difficult but, like learning to play a musical instrument or to excel at a sport, it requires some effort. The more effort you put in, the more you get out of the endeavor.
Simple, 'that's useful' routines can require very little expertise, while the all-encompassing, mega-app will take much, much more.
Most of us will use what is available already, and supplement it with a few little scripts to help take away the drudgery of day-to-day requirements.
About programming and scripting
New computer users usually fall into one of two categories: those who see themselves as potential programming gurus, and those who would rather just not know about such evil practices. Both are usually misinformed and, whichever direction they eventually follow, disappointed with their experiences.
It is not necessary to be able to write computer code to achieve a satisfactory relationship with the capabilities (and complexities) of a computer. However, those who do learn to use some of this additional ability tend to get so much more from their computing time.
Choosing a language or script
Under Linux operating systems, the most used scripting language is almost certainly the shell scripting language, usually, but not always - bash. Most Linux users tend to start using the bash scripting language when beginning to write their own little routines to supplement, or to replace, the utilities that are built into the system. Also, most of these users remain loyal to this strategy.
After a while, it becomes apparent that there are some things that take a lot of effort to accomplish, more effort than they will save, and some that require a little bit of 'heavy lifting' code to accomplish.
Thankfully, some other people have realized this and produced their own versions of programming environments in order to:
'make the easy things easy, and the hard things possible'
(Larry Wall, inventor of the perl scripting language).
The first consideration I had was whether to use a compiled or interpreted language. There are some languages that support both interpretation and compilation, but ultimately the user usually decides on the way to go.
Compiled languages
C is a compiled language, which means that you have to write the code and then run it through a program called (unsurprisingly) a compiler. This converts your code, written in text, into the mysterious instructions understood by by the computer’s processor. If this succeeds, which it almost never does on the first few attempts, then another program called a linker is called up to join up your bits to the system’s own bits in order that the two can cooperate.
The compile-link process can be done seamlessly using an application known as an integrated development environment or IDE. (These IDE’s are available for most computer languages, not just compiled languages, and they really do help speed up the development process). Even so, you have to complete the process before you know if you have produced something usable.
Another compiled language is C++, which is a different flavour of C. C++ uses Object Oriented Programming (OOP), where C is a procedural language. See here for an explanation. Which one to use is mostly down to personal preference, as both are extremely powerful languages. So should I use a compiled language? No, not for writing quick fixes and small helper utilities. C is good. Unix was written in C, as were most of the GNU utilities, and of course, the Linux kernel. If you want to write device drivers or low-level systems utilities, use C. If you intend to start out from scratch and write '2nix' then choose C. If you want to do that and annoy the hell out of Linus Torvalds, then choose C++. For my purpose I wanted something lighter.
Interpreted languages
Interpreted languages tend to be lighter and easier for newcomers to grasp. This is why, when home computers first appeared on the scene, most came with a BASIC (Beginners All-purpose Symbolic Instruction Code) language interpreter installed. BASIC is not, however, a 'good' language, and can lead to some very poor programming habits. An interpreted language is written in text which is passed to an interpreter. This reads an instruction and executes it and then waits for the next instruction. This way you get to see the results immediately as each instruction is executed. Actually, most interpreters these days do two passes over the code. The first pass optimizes the code for interpretation, and the second pass performs the execution although this is invisible to the user.
Perl is an interpreted language, and many of the PCLinuxOS configuration utilities are written in perl. Therefore, I looked at perl. I was impressed. Perl is vast and has been around since at least 1987 (Larry won't say exactly). In that time, almost anything that can be done in perl has been done by someone, and that code is available for re-use in a central repository named CPAN - The Comprehensive Perl Archive Network. Perl is available for free on almost any platform, Linux, BSD, Windows, Mac and others. Most Linux distributions install it by default.
The documentation is as near complete as the documentation for a project of this size can be. Online tutorials are plentiful, and books on perl abound. Perl is also easy to use. Well, at least the beginnings of perl are easy, but adventurous folk can get as deeply involved as they like. One of perl’s maxims is 'there is more than one way to do it' and this is certainly true. If you have a perl problem and try to Google the answer, you are likely to get five people come up with eight different solutions, all of which work.
So, is perl the language that I should choose? No. The problem with perl is its completeness. There is just so much of it and so many ways to do things that I felt lost, I was drowning in a sea of possibilities. For some this is a plus, but I felt overwhelmed so I could not concentrate on the problem at hand. I agree with Forrest Gump -- 'Simple is as simple does.'
A friend suggested I try Java. I did. Again no. Why not? I didn't like it, simple as that. It may be the perfect solution for some folks, but not for me.
Next up came Python, a language that has been around as long as perl (1987) but has in recent years become the darling of coders in the open source world. A wonder language -- I wonder...
There are currently two versions of Python, similar but incompatible with each other: Python 2 and Python 3, with current releases at 2.7.10 and 3.5.0 respectively. Python 3 is stable but still in development, while Python 2 is also stable but unlikely to receive new features. Python 2 is not going to disappear any time soon, as there is too much existing code dependent upon it, but Python 3 is the way forward. I decided to try Python 3.
Python is an interpreted, object-oriented language that can also be used as a procedural language. Object-oriented because everything in Python is an object, but if you don't like that way of working, don't want to have to use classes and methods, use functions. Python will take care of the details, but then you will miss out on some of the power of Python.
OOP is not difficult, but it is different if you are used to the traditional way of coding. Python allows you to transition at your own pace. Once you begin to grasp the concepts of OOP, you can appreciate the simplicity and power available. Like perl, Python has a wealth of ready written code available in the form of importable modules, has excellent documentation, is free to use, is available on most platforms, and is installed by default in most Linux distributions.
So, once again, should I choose Python as my development platform? Yes, because unlike perl, I didn't get that feeling of being overwhelmed. Like perl, there is more than one way to do it, but unlike perl there is only one correct way to do it and the structure of Python tends to lead you towards that level of correctness. However, Python is tolerant if you do wander from the straight and narrow.
Often, compiled programs are used in speed critical situations. An interpreted language may call a compiled module to optimize the execution, as interpreted languages tend to run more slowly. Python has some useful features that help to speed things up. Here's an example:
One way of benchmarking programs is to perform many iterations of a repetitive task and to record the time taken. A Fibonacci sequence is a series of numbers such that the next number in the series is the sum of the previous two numbers -- 0, 1, 1, 2, 3, 5, 8, 13...
To find the largest Fibonacci number in the range 0 to n in python

To time the run of this routine this is called with:
time fibo_test.py n
Where n is the number to stop at.
I did this for two maximums, 1e3 which is 1000 and 1e308 which is 1 followed by 308 zeros, a ridiculously large number that should seriously test the routine. The screenshot shows the results.

Quick enough for me.
So, Python it is then. I've only been using it for a couple of weeks, but I like it. From the few examples that I've tried, OOP seems to make integrating GUI components much easier, so I think I'll stick with it a while.
I know that Linus thinks that C++ and OOP are an abomination, but then he's biased. He's a genius. For me, all things are difficult, and hard things are very difficult. But perhaps, with python, they are all achievable.




Inkscape Tutorial: Creating A Jigsaw Puzzle Using The Lasercut Extension
by Khadis
A couple of months ago I wrote a tutorial about making jigsaw puzzle pieces manually. I realized that it took a long time to create it, although it still good to sharpen your designing skill. But, thanks to the Inkscape community, working in Inkscape is now getting easier each day -- including creating puzzle's pieces instantly.
In this issue, I will show you how to create jigsaw puzzle instantly using Lasercut extension. OK, let's go!
To get started, download the Lasercut extension (Lasercut-jigsaw.inx) from https://github.com/Neon22/inkscape-jigsaw. If you cannot download it directly, just copy the script into your favorite text editor, then save it in the <.inx> format with name "Lasercut-jigsaw.inx".
Also, download the python script (Lasercut-jigsaw.py) from the same address above. Simply copy the script into your favorite text editor and save it with a <.py> format.
Put those 2 files in the usr/share/inkscape/extensions/ folder and start your Inkscape. If it doesn't work, put those files in ~/.config/inkscape/extensions/ folder. You'll find this new extension under Extensions -- Render -- Lasercut Jigsaw menu. If it still doesn't work, try to run Inkscape using root mode.
Now, import an image to your Inkscape. I used a random free image from http://www.123rf.com/. Look at its dimension. Mine is 562.5 x 435 px.

Go to the Extensions -- Render -- Lasercut Jigsaw menu entry. A Lasercut window will appear in your screen. Set the width and height the same as your image dimension. Also, set the number of pieces across and down (see the illustration below). You can experiment with the number of pieces to gain a better result.

Click Apply and your puzzle pieces will appear in the center of your working canvas. By default, they are fairly hard to see because the stroke is very thin. So, open up Fill and Stroke (Shift + Ctrl + F) panel and increase the stroke width from Stroke Style tab.

After that, put the puzzle above the image (click the puzzle and press PageUp button to ensure). Then, select all (puzzle and the image) and center them through Align and Distribute (Shift + Ctrl + A) panel.

Done. You can later cut the puzzle into pieces by following the pattern. Good luck.




Tip Top Tips: Running Multiple Logitech Devices From One USB Receiver
Editor's Note: Tip Top Tips is a new monthly column in The PCLinuxOS Magazine. Each month, we will feature -- and possibly even expand upon -- one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum's "Tips & Tricks" section. Your tip just may be selected for publication in The PCLinuxOS Magazine.
This month's tip comes from PCLinuxOS forum member Ramchu.
I just purchased a new Logitech wireless keyboard. In the instructions, I noticed paragraph for running up to six (6) compatible devices from a single USB receiver. I went to http://logitech.com/support/. There I discovered that, once again, Linux isn't (officially) supported. I searched with Google and discovered that there was a workaround.
I then searched in Synaptic for unifying and discovered Solaar, installed the package, then opened solaar from a terminal.
I now have my Logitech wireless mouse and wireless keyboard both working from a single USB receiver .
For your Logitech product to be compatible, this logo should be located somewhere on the equipment.

From the description in Synaptic:
solaar
Device manager for Logitech's Unifying Receiver
Solaar is a Linux device manager for Logitech's Unifying Receiver peripherals. It is able to pair/unpair devices to the receiver, and for most devices read battery status.
It comes in two flavors, command-line and GUI. Both are able to list the devices paired to a Unifying Receiver, show detailed info for each device, and also pair/unpair supported devices with the receiver.
Most of you may already know of solaar. I didn't, and I am sure others don't either. I hope this helps someone.



Game Zone: Stick 'Em Up 2: Paper Adventures
by daiashi

About The Game
Stick 'Em Up 2: Paper Adventures is a run'n'gun/platform game of stick figure characters fighting through paper and card levels.
Fly across city rooftops firing rockets from a helicopter, leap between pirate ships with a sword, race buggies on the moon, and more!
Play with between 1 and 4 players with extra controllers or by connecting over your local network.
Game mode include playing together in campaign mode, or fight against each other in VS and Team VS modes
First let me say the game is short, but for the price, definitely worth it. The levels that you fight through were, in my opinion, well thought out for what they are and enjoyable to play through. If you like South Park's construction paper type back drop, then you will surely like this. As a side note, if everyone does not have the full version to join a game, the starter edition can be used. What an ingenious addition to a game to get everyone involved. I hope you enjoy the game. I know I did.
System requirements:
Fully updated PCLinuxOS and Steam
Hardware:
Minimum:
Processor: Intel Core 2 Duo or equivalent
Memory: 1 GB RAM
Graphics: OpenGL 2.0 or later
Hard Drive: 150 MB available space
Additional Notes: Supports mouse and keyboard, Xbox 360 controllers, Xbox One controllers, and other Steam-configured controllers
About The Company
Never Don't Play is the company behind this game. However, not much could be found about those responsible.
Some Gameplay Screenshots





Getting It To Run
Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab and search for Stick 'Em Up 2. Click on and download the demo. If you have updated your system, including graphics drivers, you should be good to go.
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